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1. Scope

This document is an introduction and explanation of the DP4100 Cardsetup Software. With the
assistance of this document the user will be able to generate Flash Cards Announcement and /
or Music play back together with the Becker Avionics DP4100 Digital Player.

For a description of the DP4100 Digital Player refer to the following DP4100 manuals :

DV 62500.03 "Aircraft Maintenance Manual" Article-No. 0530.700-071
DV 62500.04 "Component Maintenance Manual" Article-No. 0530.719-071

1.1. Scope of delivery

The following articles are contained in the scope of delivery:

Name of the item Article-No.
DP4100 Cardsetup Software (CD-ROM incl. manuals in PDF format) 0546.763-909
Cardsetup Software for DP4100 Installation and Operation Manual 0544.736-071

1.2. Accessories

Name of the item Article-No.
Demo Flashcard 0546.658-909
Compact Flashcard 2 GB with ATA-Adapter 0648.744-956

Note: The Compact Flashcard 2 GB with ATA-Adapter can replace the ATA-Flashcards.

Note: The free memory space of used cards depends on the preinstalled data files.

The contents of this document is property of

Becker Avionics GmbH e Baden Airpark
D-77836 Rheinmunster ¢ Germany

and may not be copied or duplicated or published without written consent.

©2016 by Becker Avionics GmbH, all rights are reserved.
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2.  Requirements

2.1. System

The minimum installation for proper operation should be :
e PC or Laptop with Windows 95/98 (NT)

e CD-ROM drive
e Soundcard and Soundsystem
e PCMCIA connector

The PCMCIA connector may be included (Notebooks ...) or connected via special hardware or
local printer port. The drive must be accessible via a drive letter.
In general standard hardware will work fine.

2.2. Data Format

The program works like a post-processor and expects all sound files, speech and music, in
mp3 file format. All files must have the extension mp3.

2.3. Flash Card

For operation with the DP4100 only Flash Cards of type 1 or type 2 with ATA file system must
be used. Linear Flash cards will not work. Type 3 flash cards will not fit into the DP4100 player.

We recommend to use Flash Cards from SanDisk Inc. they have been 100% tested and are
available from company Becker Avionics. There is no guaranty of proper operation if other Flash
Cards than those from SanDisk are used.

All available memory sizes from SunDisk Flash Cards can be used.

2.4. Compact Flash Card (CF)

Today the media type (PCMCIA) Flashdisk is not longer available on the market. The PCMCIA
interface is in fact a superset of 40-pin AT Attachment (ATA) interface and 50-pin Compact
Flash (CF) interface. So makes it possible to connect the named interfaces with a special pin-to-
pin adapter, containing no electronic components.

The card should be preliminary inserted into a PCMCIA adapter and then they can be used as a
Flashdisk replacement.

2.4.1. CF + PCMCIA adapter
The following combinations were tested:
o Adapters: Epson, NoName, Pretec, Targa Visionary.

e Cards: SanDisk CF 512 MB, SanDisk Ultra Il 4 GB, SanDisk Ultra Il 8 GB.
All of named combinations were working without any problem.

April 2016 23'30'06 Page 7 of 32
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3. Implementation Notes

Following restrictions should be taken into account:
e The DP4100 digital player can play .mp3 records with the max constant bitrate
160 kB/s.

o The DP4100 digital player can play .mp3 records with the max variable bitrate
180 kB/s.

o The DP4100 digital player can accept cards with the max size 2 GB.

o The DP4100 digital player can accept cards FAT formatted only.

The described operations were tested for Window XP, Windows 7/8, Windows 10 operational
systems (OS).

Page 8 of 32 23'30'06 April 2016
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4. HowTo

The following steps describe main operations with cards and adapters and are independent of
card and/or adapter type. PCMCIA, CF or the USB card adapters/readers can be used.
Physical capacity is a maximum volume of information that could be placed on the card. Card
size is the maximum volume of information that could be placed on the partitioned and
formatted card part.

4.1. How to copy/clone the existing card

The operation can be used to replace the existing Flashdisk media.

Download the executable copy/clone tool:
http://hddguru.com/software/HDD-Raw-Copy-Tool/HDDRawCopy1.10Setup.exe

Insert the source card into adapter/reader and start the copy/clone tool.
Create and save the source card image, then close the tool.

Insert the target cart into adapter/reader and start the copy/clone tool. The physical
capacity of target card should not be less than source card size.

Create and save the target card using source card image, then close the tool.

The target card is now the exact byte-by-byte copy/clone of the source card.

4.2. How to reduce card capacity down to 2 GB

If the physical card capacity exceeds 2 GB the card size should be reduced.

Note:

Insert the card into adapter/reader and ensure the card is visible for OS. Use e.g.
Windows Explorer for this.

Open the OS command prompt typing in series “WinKey + R”, “cmd”, Enter.
In the command prompt type “diskpart”. You should see “DISKPART>" prompt now.

In the command prompt type “list disk”. Find the corresponding card and its number
in the occurring media table.

In the command prompt type “select disk N”, where N is the card number in the disk
list.

In the command prompt type “list disk” again. Ensure the needed card media is
marked with “*”.

Be extremely careful and don’t mix up the needed card with the system
media!
The media partition table and media format will be lost after next operation!

In the command prompt type “clean”. Card partition and card format will be deleted.

In the command prompt type “create partition primary size=2047”. The card partition
with the size 2 GB will be created now.

In the command prompt type “format fs=fat quick”. The card will be now formatted.
In the command prompt type “exit”. The command prompt will be now closed.

The card is now prepared to be used as a DP4100 media and the data system can be created
using card setup software.

April 2016
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5. Installation

5.1. Starting Installation

To install the Cardsetup software insert the CD-ROM into a CD-ROM drive, open your
explorer.exe and view the CD’s content. Double clicking setup.exe will start the Setup Wizard,
guiding you through the installation. The setup can be cut short anytime by clicking the "Cancel*
button.

5.2. Destination Folder

First you will be asked for the software’s destination folder. A default install folder is offered and
can be changed by pressing the Browse button.

Choosze Destination Location

Setup will inztall Becker DP-4100 Cardzetup +1.0 ik the following
directon,.

T o install to this directary, click Mest.

To inztall to a different directon, click Browsze and select anaother
directon,.

Y'ou can chooze not ta install Becker DP-4100 Cardzetup «1.0 by
chcking Cancel to exit Setup.

C:h.\Becker DP-4100 Cardzetup 1.0 Browse. .. |
Cancel |

|' Destination Directany

| etallEhield

< Back

Figure 1 Destination Folder Setup

¢ Press "Next to continue installation.

Page 10 of 32 23-30-06 April 2016
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5.3. Program Folder

The next step requests to select a Program Folder, which is accessible via the "START" menue.
The predefined folder can be used or changed to the individual needs.

Select Program Folder E3

Setup will add program icons to the Program Folder listed below,
ou may bppe a new folder name, or zelect one from the existing
Folders list. Click Mest to continue.

Program Folders:

Becker &vionicz

Exizting Folders:

| Frebal Ehreld

¢ Back I Mest » I Cancel

Figure 2 Program Folder Setup

e Press "Next” to continue installation.
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5.4. Copying Files

All the information from the previous pages are displayed, check the settings and press "Next"
to start copying the files or "Back" to edit the settings again.

Start Copying Files E3

Setup haz enough information to start copying the program files.
|F wou want to review or change any zettingz, click Back. 1f you
are zatisfied with the zettings, click Mext to begin copying files.

Current Settings:

Setup Type: ﬂ
Complete

T arget Folder
C:%ProgrammetBecker dvioniczhBecker DP-4100 Cardze

Ilzer Information
Mame: Entwicklung
Company: Becker-Flugfunkwerk GmbH

4| | 3
Cancel |

| Frebal| S held

Figure 3 Start Copying Files
5.5. Setup Complete

After setup has installed all files the Setup Complete window will appear. Press cursor on
"Finish® to complete the installation.

Setup Complete

Setup has finizhed installing the application on wour comprter.

Tou may launch the application by zelecting the icons installed.

Click Finizh to complete Setup.

| Fratal| Ehreld

¢ Banh

Figure 4 Setup Complete
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6. Starting Software

6.1. Main Screen

Start the Cardsetup Software via your "START* button on the task bar and select "Programs*
and the previous defined destination folder. The following main screen will appear:

8 DP-4100 Cardsetup =[O x|

File Options Help
zlalo] | ulaf g
o [ (A 1SIC

IZ[]J) huzic EI

oLt Gettings

Figure 5 Main Window

The main window is divided in:

6.2. MENU Bar

This is the standard WINDOWS menu bar and is the upper bar in the main window.
6.3. TOOLBOX Bar

Is located under the menu bar and has icons with shortcuts.

6.4. CARD TREE Window

Is the white window on the left in the main window. The window shows the Flash Card tree for
the current used project. Content depends on allocated card type.

6.5. BROWSER Window

Is the white window on the right side of the main window. The window operates like a normal
browser.

6.6. MESSAGE Window

The message window is the gray part at the bottom of the main window. This window shows
messages from the program. Status information and missing links will be displayed here, also.

April 2016 23'30'06 Page 13 of 32
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7. Menus & Submenus

7.1. File Menu

In this menu there are 4 choices and "Exit* for finishing the Cardsetup application.

7.1.1. Start a new Project

Every time you create a new data set for a card, you start with "New". See also "Creating a
Music Card", page 26 and "Creating an Announcement Card", page 16.

7.1.2. Open an existing Project

If you have a previously defined data set and want to open it you will start with "Open*. This has
the same effect as opening the project in the navigator toolbox. See figure 9.

7.1.3. Save the current Project

If data compilation is finished, the current project for later review or additions can be saved. The
file ending is .dp. This has the same effect than as savening (figure 6) in the navigator toolbox.
7.1.4. Save the current Project as new Project

In order want to save the current project under a new name select "Save As*.

g DP-4100 Cardzetup

Optionz  Help

Y

Open
Eave & dio

Save fs

E it
Figure 6 File Menu
Option Menu

In this menu there are two choices :

7.2.1. Change the settings for the current Project

For each project can be change the settings individually. Submenu "Application” allows to select
and define languages. Submenu "Card“ allows to change the configuration parameters of the

card.
8 DP-4100 Cardsetup
Eile | Options Help

= Settings Application |
Card
Create Card =

------ Lard type: Music

&

------ 0 Muszic

et SEMINGE

Figure 7 Options Settings

7.2.2. Create the final player card

If the project is finished, create the final player card with this submenu entry. The creation of the
card includes the checking of the links to ensure that nothing was forgotten to include. If there is

Page 14 of 32 23-30-06 April 2016
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an error during this check the card will not be created. In this case the lower grey window will
give the error information. Double clicking on the errors will show directly the problem.

O DP-4100 Cardzetup
File | Optionz Help

Settings r

Create Card
e Lard tppe: Muszic

...... :, b uszic

et Settings

Figure 8 Option Create Card

7.3. Navigator Toolbox

The navigator toolbox (Fig. 9) in the upper window offers the following features from left to
right.The first 3-button block offers :

7.3.1. Project Management
with shortcuts to
e open an existing project

e save the current project
e select parent directory

The second 3-button block offers:

7.3.2. Integrated MP3 Player
The Cardsetup software comes with an integrated MP3 player supporting this basic functions:
o play selected file

e pause playing
e stop playing

For playing a file, the file must be selected in the right window or the according link in the left
window.
From the file type selector only MP3 files are accessible.

sl @& »| n| m| [MFaFes =

Figure 9 Navigator Toolbox
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8. Creating an Announcement Card

Follow the paragraphs to create an Announcement Card.

8.1. Introduction

The program was designed to allow context sensitive operation. The Context Menu is invoked
by pointing to the according mission or announcement and pressing the right mouse button. The
following figure shows the Context Menu :

e

G DP-4100 Cardsetup
i

Options  Help

slala| »|n|mfMm

1 Missi ;
_____ - Seftings Mizzion options
Pazte
Welete

[ Card type: Announcement
o Music

o LH 295

=0 BOARDING

MHew mizsion

Mew announcement

Set as predefined

LCreate card

Figure 10 Context Menu for Announcement Cards

Page 16 of 32
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8.2. Setting up the Project

Select File -> New -> Announcement.
The left window will show the structure of the announcement card and a window will open,
asking for a mission name.

g DP-4100 Cardsetup
i

e Options  Help

| &&= »| n]| m| [MraFe =]
w0 Disk type: Announcement
I]]!I:l Music E’
et Settings
New Mission |

Eniter Mizzion Mame

kizzion 01

k. I Cancel

Figure 11 New Mission

This can be a flight with flight number. Enter a mission name and press "OK". The mission
name will appear in the left window. By pointing to the mission name and pressing the right
mouse button you can select from a context sensitive menu via also.

There is always a mission called MUSIC. You can’t delete this mission, if you don’t use it, it will
not be generated at the card. Use this mission to copy pure music files to the card. You can
select them later on the DP4100 digital player under the mission MUSIC.

April 2016 23'30'06 Page 17 of 32
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8.3. Definition of Mission Languages

The next do is to select the languages for that mission. Keep in mind that every mission can
have a different set of languages.

Point to the mission in the left window, press the right mouse button and select mission options.
The following window will appear:

Miszion options |
Awailable languages Selected languages
E nglizh Frenich
Finnizh German
French Swedizh
Germnan -
[talian | S
Swedizh
< -
Intro
|N ane Change |
Cancel |

Figure 12 Mission Options

Select from the available languages at the left side the languages for the current mission and
transfer them to the right side. If a lanuage is needed which is not listed at the left side, define a
new language with "Options” -> "Settings* -> "Application®. see also "Language Mangement",
page 21.

Page 18 of 32 23-30-06 April 2016



BECKEIR
&=

Installation and Operation Manual
Cardsetup Software for DP4100 Digital Player

8.4. Defining an Announcement within a Mission

To define an announcement within a mission point to the mission with the mouse, right click and
select "Add Announcement®. Announcement name has to be defined. Enter a name like
BOARDING or whatever announcement might fit. After pressing "OK" the announcement will
appear in the left window, showing the selected languages with the banners (if defined,
otherwise empty). The left window should show something like:

8 DP-4100 Cardzetup
i

le Optiohz Help

= | i | | ’ | I | | | IMF'3 Files
----- [ Card type: Announcement
----- 0% Music

-0 LH 295
=0 EDARDING

Figure 13 Announcement Languages
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8.5. Assigning an Announcement

To assign an announcement select a MP3 file from the right side. Move the MP3 file with the left
mouse button pressed directly to the language (drag & drop). An informational window will
appear giving information about the size and location of the MP3 file. Click "OK" and the link is
established.

Assign a MP3 file to every language of your announcement.

Announcement file
File G:AProjekte\DP4100%nit-files\DP4100-00245 o Change |
Size |829 kB
Ctatuz 0K
] Cancel |

Figure 14 Announcement File

Important:

The DP4100 is only supporting the 8.3 file format. That means that the file does not have
longer file names than 8 characters and 3 characters for the extension after the dot. The
equipment will not recognize longer filenames even if they are reduced to 8 characters by
truncation. Please rename all files accordingly before you start to drag & drop.

8.6. More Missions and Announcements

More Missions and Announcements can be inserted to the project. Repeat the previous steps to
add more missions and announcements.

8.7. Removing Missions and Annoucements

To remove missions and announcements by pointing to the according mission or
announcement and press the right mouse button. In the Context Menu select "Delete”. If you
delete a mission, all announcements within this mission are also deleted.

8.8. Overwriting Links

In case a wrong MP3 file is selected take the desired one and drag and drop it again. A
confirmation will be required.

warning

A walid link already exists.
Dvenvrite?
Mein |

Figure 15 Existing Link Warning
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8.9. Application Settings

The application settings window allows to set the standard working directory path. Under
"Startup Directory” this entry can be modified to the needs.

8.9.1. Language Mangement

There are a hundreds of languages used all over the world. To allow operation all over the world
the program supports language management. For the current project a set of languages can be
defined with the possibility to mark them available for selection. In the following figure only 6
languages are marked for usage.

Application Settings |
— Startup directory
|E:"~F'FEEIGF|.¢'-.”1 “BECKER~1YBECKER™1.085ound Change |

— Define languages

L] Dutch (DU, C:\PROGRAMMENBECKER AVIOMICSNBECKER DP-411
English (EM , CAPROGRAMMENBECKER AVIOMICSABECKER DP-41
Finnish (Fl . C\PROGRAMMESBECKER AYIONICSABECKER DP-410
French (FR . CAPROGRAMMENBECKER AVIOMICSABECKER DP-411
German [GE . CA\PROGRAMMENBECKER AVIOMICSABECKER DP-4
ltalian (IT . C:A\PROGRAMMENBECKER AYIOMICSSBECKER DP-410C
L] Marwegian [NO , C:\PROGRAMMESBECKER AVIOMICSA\BECKER DF
L] Spanish [SP . C:A\PROGRAMMENBECKER AVIOMICSABECKER DP-4
Swedizh (W, CA\PROGRAMMENBECKER AYVIONICSABECKER DP-

=T | Delete |

Cancel |

Figure 16 Application Settings

If it is wanted to delete a language, select the language, mark the language with a left-click and
press the according button. If it is wanted to add a language press the "New* button.

Press "Ok" to close the Application Settings window with saving the changes, press "Cancel“ to
close the window without saving the changes.
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8.9.2. Defining a new Language

To add a language to the pool press "New" and fill in the language window. Give a name to the
language. It can be any name. Assign the language an icon, if available.

Application Settings x|

— Startup directory
|I:: YWPROGRA™TMBECKER~1ABECKER~1.0%50und Change |

— Define languages

Eng -4
Firn [~ Mew language 110
Frer L411
Ger P-4
Italic | Language name | 10C
[] Man OF
[ Spa P-4
Swe | Select icon &+ Diefault P-:
" leon
[Ehange |

Caricel |

Figure 17 Define new Language

Press the "Ok“ button and the language appears in the pool. Mark the checkbox of the language
and the new language can be selected under MISSION OPTIONS in the Context Menu.
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8.10. Saving the Project

If all links are established or just in order to save the actual work, save the project by pressing
the floppy button in the TOOLBOX or selecting "File* -> "Save as” in the menu bar. Anyway a
WINDOWS typical "save as“ window will appear. By default the working directory from the
Application Settings is used. Enter a project name and save the project.

g DP-4100 Cardzetup
i

le Optionz Help

sl &@| @] »p| 0| m| [FTamzme 5]

""" o Cadpe: Amnerce N - | |
----- 0% Music .

-0 FLIGHTOT Save in: | ‘=3 Becker DP-4100 Cardsetup v1.0 | =

=0} BOARDING &
EJE English |cons
- Gemman 1 Sound

File name: “ dpl | Save I
Save as type: IDF' 4100 Files [*.dp] =] Cancel |

Figure 18 Saving the Project
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8.11. Creating the Card

Now the creation of the Flash Card can be done. Use right mouse click to open the Context
Menu and choose "Create Card“. The program will now check all links in the project to ensure

that all announcements have a valid link. If a link is missing the message window will produce
an output like:

Time: 16:249:38

Checking rmusic ...
YWarning: Mo tracks are present! (kMission Musicwon’t be created)

Checking announcements ...
Error. FLIGHTO1/BOARDIMNG{German ... Link missing!
Etrar: FLIGHTO1,/BOARDING/French ... Link missing|

& Error(s)

Figure 19 Link Error

In this case 2 links are missing, that means there is no MP3 assignment for
BOARDING/GERMAN and BOARDING/FRENCH. By double clicking the error the program will
show the actual settings.

Announcement file |
File | None Change |
Size | kB
Statuz | Link rmizzing
Cancel |

Figure 20 Announcement File Information

With pressing "Change” can be assign a MP3 file. After file selection press ENTER. You can
also use the recommended drag & drop operation to assign a MP3 to an announcement.
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8.11.1. Select destination drive

To check the links again open the Context Menu and select "Create card” again on. If all your

links are ok, the following window will appear:

Create card

]|

Select drive

@

Enter card name

ILI zer Flightz

Ok

Cancel

Figure 21 Create Announcement Card

Select the drive which has the PCMCIA slot connected. In our example drive M: is used. Make
shure an empty Flash Card is inserted and formated.

Enter a name for the card and press OK. The cards directory structure will be created and all

files will be copied and generated.

The Flash Card is now ready for operation in Becker Avionics DP4100 Digital Player. The card
name will be displayed on the DP4100 display if is the card inserted. It's not the card label to be

seen under the Flash-Card properties !
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9. Creating a Music Card
Follow the paragraphs to create a Music Card.
9.1. Introduction

The program was designed to allow context sensitive operation. The Context Menu is invoked
by pointing to the left window and pressing the RIGHT mouse button. The following figure
shows the Context Menu:

g DP-4100 Cardsetup
i

le Options Help

s|la|la| »| n| mf

i iﬁr*
P] } g Mew Track
...... -t Ce
Paste
elete

Stostart track

Create card

Figure 22 Context Menue Audio

9.2. Setting up the Project

Select "File“ -> "New" -> "Music".
The left window will show the structure for the music card.

8 DP-4100 Cardszetup

File Dptions Help

slalal »|n|m|s

Figure 23 Music Card Structure
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9.3. Adding a Track

Tracks in MP3 format can be added easily by dragging the tracks from the right explorer window
and droping them to the music symbol. You also can add tracks with the Context Menu. In both
cases the following window will appear:

Track file |
Filz |I3:'aPru:.iekteHD P41 00%imit-fileshDP41 00-00245
Title ITrack m [max. 16 characters]
Aurtist I
Size 829 kB
Status DK
] Cancel

Figure 24 Track File Window

The entries "Title* and "Artist“ should be filled in. They will appear in the DP4100 display for
easy identification. Press "OK* to close the window.

To see what title and artist are behind a track, move the mouse over the track and a yellow
cursor window will show artist and title.

Important:

The DP4100 is only supporting the 8.3 file format. That means that the file does not have
longer file names than 8 characters and 3 characters for the extension after the dot. The
equipment will not recognize longer filenames even if they are reduced to 8 characters by
truncation. Please rename all files accordingly before you start to drag & drop.

9.4. Deleting a Track

You can delete a track by marking the track with a left click and then open the Context Menu
with a right click of the mouse. Select "Delete” to delete a track from the tree.

9.5. Changing Track Order

The order of tracks can be changed by selecting a track with the left mouse click and moving
the track up or down in the current track list with pressed button. The naming track 01,

track 02 ... is not changed but the contents are changed. Check the contents by moving the
cursor over the track and review the yellow windows contents.
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9.6. Card Settings

The “Settings” entry enables adjustment of the default behavior of the DP4100 with power on.
Defined settings can be adjusted during normal operation. These adjusted settings will reset to
the default values (described here) after the DP4100 is powered on again.

I DP-4100 Cardsetup

Fil=  Optionz  Help

sl @&l »| n| m| [MFaFes r

o [l Card typer Music
O Music ﬁ,

RO C. i s

Franzg

Figure 25 Cardsetup

By double-clicking the “Settings” entry the following window will appear:

E =ternal *iring General
" External Waolume Contral [FIN 17] [T &uto Start after Power on I "'l
% External llumination Contral [FIM 22) [T Intemal Waolume Adiustment
Predefined announcemnent Minirnumm volume
Mane | I A | 100
Delay between tracks Yalume of plavback
| 4|02 T I R R
Brightneszs of panel Treble of playback.
T I ll_bl 43 % I I ll_"l a0 %
Brightrnezs of LCD B azs of playback
T | ll LI 43 % I | ll _FI B3 X

Cancel |

Figure 26 Settings

9.6.1. External Wiring

If the installation has an external potentiometer, this can be connected to pin 17 for volume
control or alternatively connected to pin 22 for lllumination control. Please check your
installation and select the correct wiring entry in this field.

Page 28 of 32 23-30-06 April 2016



BECKEIR
&=

Installation and Operation Manual
Cardsetup Software for DP4100 Digital Player

9.6.2. General

Selection of the “Auto Start” check box enables the DP4100 to play automatically after power is
switched on. By default (if you start a new project) this function is disabled.

Selection of the “Internal volume Adjustment” box enables volume control with the rotary switch
located on the DP4100 panel. This function is disabled by default.

Attention: If you select “External volume Control” (External wiring) and “Internal volume
Adjustment” (General) then “Internal Volume Adjustment” will supersede “External Volume
Control”.

9.6.3. Brightness

Brightness for the panel and the display can be adjusted individually according to the installed
position in the aircraft. These values can be adjusted during normal operation but are reset to
the default values on every new application of power.

9.6.4. Volume, Treble, Bass

This values can be adjusted individually according the installed position in the aircraft. These
values can be adjusted during normal operation but are reset to the default values on every new
application of power.

9.6.5. Minimum Volume

This entry defines the minimum volume for the DP4100. If you use internal or external volume
control, the volume will not be lower than the value defined within here.

9.6.6. Delay between Tracks
This entry allows you decide the time of silence between to consecutive tracks.

Remark:

If you do not want to have these initial values every time the player is switched on, remove the
relevant entries from the .ini file manually. In this case the last chosen values are stored in the
DP4100 non volatile memory and remain for each application of power. It is not recommended
to modify the .ini file manually, but this may be necessary for certain applications.

We recommend that the correct DP4100 setup is incorporated on initial installation into the

aircraft and stored within the project. This ensures that the optimal values are used every time
the DP4100 player is switched on.
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9.7. Saving the Project

If all links are established or just to save the actual work save the project by pressing the floppy
button in the TOOLBOX or selecting "File" -> "Save as" in the menu bar. Anyway a WINDOWS
typical "save as” window will appear. By default the working directory from the Application
Settings is used. Enter a project name and save the project.

d DP-4100 Cardzetup
i

e Options  Help

sl @& »| n| m| [ raremes =]

o [@ Card type: Music Save As HE
S Musi .

. JJL‘JS;'Crack m Save_in:l'a Becker DP-4100 Cardsstup +1.0 j gl

- J& Track 02

¥ Track 03 Jlcons
|:| Sound

- s Sethings

File name: I Save I
Save as type: | DP 4100 Files [*.dp] . Cancel |

Figure 27 Save Audio Project

E
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9.8. Creating the Card

For creation of the Flash Card, use the right mouse click to open the Context Menu and choose
"Create card“. A music card has always valid links unless referenced files are (re)moved. This
will be checked here.

9.8.1. Select destination drive

To check the links again open the Context Menu and select "Create card“ again. If all the links
are ok, the following window will appear:

Cestecard

Select drive
1] ]

Enter card name

ILlser M Lzic

] Caricel

Figure 28 Create Card

Select the drive which has the PCMCIA slot connected. In this example drive N:. Make shure an
empty Flash Card is inserted and formated.

Enter a name for the card and press "OK". The cards directory structure will be created and all
files will be copied and generated.

The Flash Card is now ready for operation in Becker Avionics DP4100 Digital Player. The card

name will be displayed on the DP4100 display when the card is inserted. It's not the card label
that will be displayed under the Flash Card‘s properties !
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We reserve the right to make technical changes.

The data correspond to the current status at the time of printing.
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